
latitude and altitude above sea
level). For more precise results

you can also supply the local air
pressure and temperature; this will

affect atmospheric refraction.
Of course the observation time is also

important for accurate calculations; the
time, date and timezone (TZ) should be
configured.

The other time parameters are
defaults: XEphem offers settings such as
dusk or UTC, but you can also specify
special dates, such as Sidereal or Delta-T.

Users are not restricted to dates after
4713 BC (0 in the Julian calendar) as is
typically the case. In fact, you can enter
negative Julian dates to travel hundreds
of thousands of years back in time. This
is ok with respect to precession, but the
planetary positions may be imprecise
due to a lack of compensation for inter-
ference between planets in these epochs.

Of course an animated or timescale
mode is important to allow program win-
dows to come to life. This allows you to
watch the planets rotate about the sun or
the stars fly through the night sky. These
controls are located in the lower right
part of the window. The menu in the
main window provides access to other
windows and dialog boxes. Before we

look into these, lets first take a look at
the data material and star charts avail-
able for XEphem.

The Stars Like Dust
By default XEphem is supplied with the
YBS catalogue (Yale Bright Stars) that
contains only 3141 stars – which approx-
imately corresponds to the stars visible
to the naked eye. There are three ways to
conjure up more stars on your screen:
you can download their data from the
Internet, use CD-ROMs or access the
required data online.

XEphem comes from the Clear Sky
Institute [1] in the USA, which
was founded in 1993 to develop

technologies for remotely controlling
observatories. You can download the
xephem-3.5.2.tar.gz package from CSI’s
homepage (see the “Installation Notes”
box), or purchase a fully featured CD-
ROM version.

After installing the program, budding
astronomers are presented with the main
window that allows you to set some
basic preferences for the observatory
environment.

The environment is actually your posi-
tion on our planet, which can be selected
from an extensive list (of towns or obser-
vatories, for example), or entered
manually (by supplying the longitude,
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What’s that bright star up there called? Is that spot of light moving over

there a plane or a satellite? XEphem (pronounced:“ex-eff-em”) provides

answers to these and (many) more questions. XEphem’s development

history started in 1990 with versions for various UNIX Systems,

MacOS X, and even Windows. We will be looking at the current 3.5.2

version. BY MICHAEL GOTTWALD

XEphemLINUX USER

Precession: Like a rotating toy top, the earth’s
axis moves through a precession caused by
the attractive force of the other planets
about every 28,000 years.This causes the
stellar constellations to appear to move.

GLOSSARY

Figure 1: The main window after launching the
program
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Sun, Moon & Stars



A number of sites on the Internet offer
downloadable XEphem catalogs [2].
These catalogs are in the program’s pro-
prietary format and end with the .edb
suffix. You can easily convert other cata-
logs using tools like cat2edb [3].

XEphem can handle different types of
stellar catalogs, such as so-called proper
motion catalogs, which are tables of
positions, motion, lumi-
nosity, and so on. 

The PPM catalog
(Positions and Proper
Motions) issued by the
Astronomisches Rechen-
Institut Heidelberg [4]
contains 468,586 stars,
and the combined
TYCHO-2 and HIPPAR-
COS catalogs (2.5 million
stars) issued by the
European Southern Ob-
servatory [5] are well-
known examples.

So-called field stars ca-
talogs contain only digi-
tized images of the stellar
sky and thus provide only
positioning and lumino-
sity data. 

The classic catalog has
to be the Hubble GSC
(Guide Star Catalog) with
over 15 million stars. This
catalog is used to position
the Hubble Space Telescope and is now
the standard catalog for commercial
astronomy programs.

The US Naval Observatory A catalog
[6] provides an even larger database
with 54 million stars – this corresponds

to about 325 stars 
in an area the size 
of the full moon.
Finally, XEphem also
supports the Digitized
Sky Survey (DSS) [7]
of the Space Tele-
scope Science Insti-
tute (STScI) and the
European Southern
Observatory (ESO).
Special functions are
provided for detailed
analysis of these cata-
logs. The digital
portions of the stellar
sky are downloaded

online from servers. This mandatory fea-
ture of DSS is optionally available for the
Guide Star Catalog (GSC) [8], if you do
not have the CD-ROM.

Besides individual stars, so-called
deep sky objects also play an important
role: these are gaseous and dust nebulae,
star clusters and galaxies. Only the
Messier catalog (with 106 objects) [9]

provides them.
Let’s leave the end-

less depths of the
universe and return
to our cosmic home.
After all, it is interest-
ing to be able to
identify the planets,
asteroids and comets
in our solar system 
in the night sky, or 
to know in advance
when a good view of
Mars will be avail-
able. With the excep-
tion of the nine major
planets and their
moons, XEphem’s own
data resources do not
provide any objects
here, but you can use
your Internet connec-
tion to perform an
update to obtain the
missing data (see Fig-
ure 2). The Minor

Planet Center [10] provides up-to-date
information on minor planets.

If this is too much effort for you, you
can always purchase XEphem on CD-
ROM. For a mere 59.95 dollars you will
then receive no less than 14 stellar cata-

logs, eleven deep sky catalogs, two cata-
logs for minor planets and comets, and
one for satellites. The manual (which 
is available online as a PDF document)
but this costs another US $12.95. The
XEphem website provides more informa-
tion on this subject.

To New Windows
The five menus in the main window
allow you to set various preferences or
provide access to other windows. You
can however, only launch one instance
of each window type, for example, you
can only launch one stellar sky window.
If you have enabled a time control, it will
apply to any windows you have opened.
The window elements, such as colors
and fonts can be configured individually
by the user. Quick help is available for
most elements, and every window has
one or more help pages. This is normally
all you need to get by – the manual is
only required on rare occasions.

The Data menu is the place to load
missing data. You can individually add
or remove catalogs for stars, minor plan-
ets and comets. This allows you to
specify the number of minor planets to
display in the Solar System view, as you
may otherwise discover that you can’t
see the wood for trees (or in this case
dots) in the Solar System window. Figure
3 shows you the options for selecting
local databases.

The Data menu also contains one
other interesting function: Search and
ObjXYZ (see Figure 4). This allows you
to display, manipulate, highlight or cen-
ter all the objects listed on the right,
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Figure 2: Internet update and online access to external stellar catalogs

Figure 3: Database with local data

Figure 4: Memory search for an object



etc.) if required. Planet moons are avail-
able, as is a background of stars (with
“Field Stars” only) – you can enable or
disable these features as required.

There is another special function for
the earth (unfortunately only the con-
tours of the earth are displayed): you can
apply the current weather chart to the
globe by connecting to the Space Science

and Engineering Center at the University
of Wisconsin (see Figure 5).

Additionally, you can project a maxi-
mum of three objects onto the globe, for
example, the position of a satellite or the
moon, and trace their progress for a spe-
cific time period. This would allow you
to plot the path of the core shadow on
the earth during a solar eclipse.

Looking into Space
The “Sky View” window provides a con-
figurable view of the sky. In addition to
the menus there are several icons and
sliders located around the window con-
tent. The night sky is first shown as a
projected globe with labels and titles. In
this case, the observer takes up a posi-
tion within a hemisphere; stars and other
objects are projected onto the inner sur-
face of the hemisphere. The field of view
is always 180° and thus loosely corre-
sponds to a fish-eye view.

Displaying a three dimensional con-
cave sphere on a two dimensional screen
obviously means that some distortion
will occur. The alternative projection
form is a cylinder, that is, the celestial
sphere is projected onto the surface of
the cylinder. This allows for a linear hori-
zontal projection (if enabled), but
distortion becomes apparent when you
move towards the celestial poles (and
most obviously so if you enable the co-
ordinate grid). The horizon can be a red

from terrestrial satellites through to glob-
ular star clusters in the “Sky-view”
window. If you have attached a telescope
(such as the Meade LX200) with a GOTO
control to your serial port, you can click
on Tel Goto to align the telescope with
the desired object. You can also use a
search string to locate the object in your
machine’s memory.

A View from Space
The View menu allows you to display the
Sky View, our Solar System or one of six
planets in a window of its own, complete
with menus and icons. The moon, Mars
and Jupiter have a realistic surface tex-
ture and you can display additional
features (craters etc.) or landing sites
(Apollo on the moon, Pathfinder on Mars,
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Figure 6: A selection of windows available in XEphem

Ecliptic:The plane of the Solar System; the
sun and planets as projected on the celestial
sphere will move across this plane.
Celestial equator:The earth’s equator as pro-
jected onto the night sky. It divides the
northern and southern celestial hemispheres.
Opposition loop:A planet’s motion is relative
to the stars in the sky. If the earth overtakes
Mars on its internal course, as it moves
quicker, Mars will describe a loop in the sky
for several months.

GLOSSARY

Figure 5: The earth with a current weather chart



line at altitude zero (sea level), or a land-
scape defined in a file; just like in real
life, nothing is visible below the horizon.

The other labels provided by XEphem
omit nothing that the astronomer’s heart
might desire, such as the Ecliptic, the
Celestial Equator or a grid of celestial
co-ordinates. You can draw today’s
boundaries for stellar constellations,
highlight well-known figures, and apply
Latin names or abbreviations. Stars from
the YBS catalog are shown with their
names (if available) or Greek letters 
by reference to their luminosity (Alpha
being the brightest), as specified 
by Johannes Bayer in his stellar atlas
from 1603, Uranometria. Other objects –
planets, satellites, galaxies, nebulae, etc.
can also be displayed as dots with or
without labels, as required.

Three slide controls are available 
to enlarge or reduce the cross section 
of the view. Right clicking an object
opens a popup with additional informa-
tion, such as rising and setting times,

luminosity, coordinates, etc. Addition-
ally, right clicking provides access to
menu functions that allow you to center
or zoom in on an object. You can 
also plot the track of an object on the
celestial background (for example,
Opposition loops).

If you simply want to know if and
when a planet will be visible in the 
night sky, it would be rather tedious to
have to cycle through various views in
the “Sky View” window. To avoid this
the program provides a visibility diagram
as one of its many useful windows (see
Figure 6).

As mentioned at the start of this arti-
cle, the program also supports terrestrial
satellites. Of course, the International
Space Station, ISS, which is currently
under construction, is a good source of
information. The easiest way to go is to
load the current Orbit elements directly
via the Web update function, by entering
“ISS” for Search during download for and
then clicking on Get in the first line of
URL defaults (stations.txt).

You can then assign the ISS to a 
user-defined object using Assign to …
ObjX. Now open the “Sky View” window
and disable any labels you do not need,
such as grids, galaxies, and so on. In 
the main window’s Data menu, select
Search memory, define ObjX,Y,Z to dis-
play the current ObjX – that is the ISS –
in the window.

Clicking on Sky point will center and
highlight the ISS in the “Sky View” win-
dow. Adjust the slider controls to display
the ISS at the right margin. Now right
click over the ISS to open the popup
menu and select Create Trail. Enter
“Now” in the Start box and define a Cus-
tom interval of 0:01 (one minute,
otherwise the gaps in the orbit are too
large). The Number of tick marks can be
set to 10 and you can then click on Ok to
plot the orbit of the ISS through the night
sky (see Figure 7). The orbit elements
should not be more than a few months
old to avoid deviations in the plot.

Extraterrestrial
XEphem also supports Seti@home
(Search for extraterrestrial intelligence at
home) [11, 13]. The project uses radio
telescopes to search for signs of intelli-
gent extraterrestrial life. To analyze the
enormous amounts of frequency data,
any- one can volunteer to use their PC as
an Internet based client, for as long as
they like. ■
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Figure 7: The ISS orbit at 6.00 am on March 8

The source code for the program is available
on the CSI homepage in the form of a tar
archive.The installation steps are compre-
hensively described in the accompanying
text file. An RPM package is available from
www.rpmfind.net (and on the subscription
CD).You will also require the Motif develop-
ment libraries [12].

Installation Notes

[1] Clear Sky Institute: http://www.
clearskyinstitute.com/xephem/

[2] Extra star data: http://astro.
uni-tuebingen.de/software/xephem.shtml

[3] Conversion program: http://www.iram.
es/IRAMES/groups/astronomy/cat2edb.txt

[4] PPM catalog: http://www.ari.
uni-heidelberg.de/

[5] TYCHO-2 and HIPPARCOS catalogs: http://
www.eso.org/

[6] US Naval Observatory A catalog: http://
www.usno.navy.mil/

[7] Digitized Sky Survey: http://archive.stsci.
edu/dss/

[8] Guide Star Catalog: http://www-gsss.stsci.
edu/gsc/GSChome.htm

[9] Messier catalog: http://www.seds.org/
messier/

[10]Minor Planet Center: http://cfa-www.
harvard.edu/iau/mpc.html

[11] Seti@home: http://setiathome.ssl.
berkeley.edu/

[12] Motif development libraries: http://www.
opengroup.org/openmotif/downloads.
html

[13] Björn Ganslandt:“Hertz Donors – Distrib-
uted Computing on Linux”, Linux
Magazine, Issue 25, p84

INFO


